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Allow user to only access certain reports/views

This scenario will allow you to make only certain reports/views accessible to a user depending
on what you want them to be able to see. Instead of hiding each view individually, this will
help to speed up that process and hide as many as you need to all at once.

Go to Tool/Modeller and select ‘Configure’, then
‘Repository Administration’.

Dashboard Capture

Configure w

Class Editor
Slot Manager

System Administration

Repository Administration

111 essential
- 4

2 Select ‘Manage Classifications’.

Confgue w

Repository Administration
L~

I\@ Manage Repository Users
|@ Create Snapshot

f@

\o5=) Manage Snapshots

(4d)
( Restore Snapshot
) ’

o~
|\@> Copy Repository

Protege Import

Protege Export

Manage Layout Groups

Manage Classifications

Theme Editor

3 ‘Create New (Security) Group’, or take note of the levels within the group.

> Team France

Frinch Preson atindee 10 omesd )] gheat)

Create News Group -

Currently lagpec ista repasitary: "Deme” oo ualtesl

Current Version: 1.12.4

Create New Level Cdit Celete
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If adding New Classification Level, enter Name \
and confirm.

Create New Levels, Edit the group
name, or Delete the group.

2 Security Test Group * | | CresteNewLevel | Edit | Delete
Med Leval atindex 2 edit delete
High Level atindex 4 Highe .
I Change the order of the index
::Z dn:rra-\ggmg the dots to desined 5 ‘Edit’ the level name, or delete it.

7 Return to configure and select ‘Manage Repository Users'.

.
EEE essent"a! Dashbosrd  Capture  Publish  Import -  Configure w
clow

Repository Administration

Manage Repository Users

®@@d®O

Create Snapshot

Manage Snapshots

Restore Snapshot

Copy Repository

NOIOIOIO

Protege Import

Protege Export

Manage Layout Groups

Manage Classifications

Theme Editor

8 Change User Edit Clearance Level to ‘Low’.

Select the user

0 Managerent Lows O Pusial View O Cwcutives Z Uventicd Vew

you wish to
apply a security ) o @ Nosgmen
classification to. S S S

¥ managemert Lawest

L.e. Low Level [Low

BA Ver e

] WMenber

) BAMeTOr




To apply a new security
9 Change the Read Clearance Levels to ‘Low’. group to a user, select

l—! the applicable security
averai Sacurt group created under

O Management {Lomest O partial view O Exacutivas Edit and/or Read

If you select Level 1 and
& Management (ighest| it will be available in the
Security Classification

[] towestiLowest)

O Analysts (Lowest) O TapSecrat & Management (Highest

o for selection.

@ manngementLowest Select Level 2 and both
Level 1 and 2 will be

W Low Level (Lowest) O MedLevel O HMigh Level (Mighest) available

]‘ Select Level 3 all levels

will be available for

Once the default is applied, user will need at selection

least the low-level clearances to access and
edit the instance.

10 Give a set of people access to certain Views only

Allow a set of people to access only specific Views. Note:
* Access to the Views is only defined at the View level
* Can be combined with Scenario 2 to control access to Portals and Views

Options:
* Use the Default Security classification and then de-classify the Views that the set of people are allowed to access
(including the Home page and a Portal)

« C(Classify all the Views to which these people are not allowed to access, with a classification that exceeds their
clearance levels

Recommended approach Example will use this
approach.

« Classify all the Views (and Portals) to which the people must not have access

1 Now apply a higher classification to the portal(s) than the user has to hide the views/classes you don’t want them
to access. E.g. Application Portfolio Management Portal (will also apply it to Data Management Portal)

3 essentiﬁ! Dashboard ~ Capture  Publish  Import w  Configur
EA class > EA Support > Class Tree ticks Instance Browser His
Essential Viewer > Portal o con ;
Configuration > Portal | ==
AL NMN ADDITIONAL ‘ SECURITY | SYSTEM DEPRECATED
Security
Select the Portal to be — )
. System Security
CIaSS|ﬂed- Edit Classification ADDYNEW
. System Security
Select ADD/NEW in g pomen

Chssification B Securty Test Group - Med Level

System Security Read
Classification.




1

Select EA System > EA Security > EA Content Classification, and the security classification
that will require a higher level to access (e.g. Security Test Group — Med Level)

» O SYSTEM CLASS

~ O FASptem > Buse- Mnrsprermnt

» GenerdlSecurty  Exccutives

Content Classification 117 | ,

L] ST

© Féa Ditaull Clisilicatian
m D Maageesnt ||

> My Classif
> Security managemant

b n Securily - Managemunt
> Generdl Security - Fartal View

» Coneeal Security - Unrestrictod View

Jors - Top Secrwt

3 Securily Test Groups - High L svel

> Security Tezt Group Low Leved

i
Main

Name

Dusesiption

WMAIN  ADDITIGNAL | SECURITY  SYSTEN DFPRECATED

Then ADD/NEW to
the System Secured
Read Elements.

13

ATdabRITCTMAS 3ed

b O I~formation Layer
» O Technology Layer
v O FASuppart

© Strategy Management
© Change Mamagerant
Standseds Maragement

»
»
»
»
¥ O Risk Nanugsmunt
»
»
»

System Seowred
Ruad Elwmmnts

ADDYNEW...

semance
© Secunty Manageent Systum Swourwd
© Service Dalivery Edit Elements
© Oblizgation Marapement
Foeus Bpad Collazar e vange
Search Caszes Search Instances Contained In
Fanbent

Currently logged Into repository. "Demo” on uattest
Current Versiom: 1.12.4

W STourty 1ozt Group - Med Level
® Applcation Fortfolo Nanagemesy: Pertal

ADDYKEW

® Security Tast Group - Mod Lovel

ADYNEW

D14 2020 EAS. S

« Select an Instance

Q

» :ESSENTIAL-CLASS (697)
» :ESSENTIAL-SLOT {1701)
» EARelation

» :EAGraph Relation

» EASecurity

14 To hide certain views/reports, select EA Class > EA Support > Essential Viewer > Report.

v EAClass

Q  Search Ust

» Business Layer
» Application Layer
» Information Layer

» Technology Layer

» EASupport

» About Essential

« EA Support + Essential Viewer

Q  searchli Q  SearchList

» Taxonomy Management -

» Utilities » Report Classification (6)
» EARepository Management » Report Group (5)

» External Integration » MenuManagement

» Value Management » Report Language (10)

1 5 Select all the reports/views you want to be hidden from the user.

v Report

Core: Application Service Summary
Core: Application Software Architecture

Core: Application Technology Alignment

Core: Application Technology Platform Model

Core: Applications Status by Business Capability
(O Core: Business Application Footprint
(O Core: Business Capability Application Fit
(O Core: Business Capability Catalogue as Table

(O Core: Business Capability Catalogue by Name

Click ‘select’ once
all the desired
reports have
been highlighted.

 p—
New ‘ Select H Cancel | 1

Use the search bar to find a specific report or category
(e.g. ‘Application’, ‘Data), to make finding the reports
you want to give access to easier.




1 Only the portals without classifications are now visible, along
with any application/data related views also being classified
J

|

Knowledge Portal

Manage, a

Application

T ————
IT Portfolio and Asset Management

Information and Data

Enterprise Architecture Haa m-mmm
The Ertenpdse Archiectune ortl Iocunes 00 views Waeh sepert R :
e LA miutus ) e >garn o
k o —
—_———

View Library

Lcore Wl views viabile Ls Exsential Wiewer Oorganased by per

Catalogues also now classified if
1 8 they’re application or data
related.

l

Catalogues

Business Capability Catalogue
Business Domain Catalogue
Business Process Catalogue
Business Service Catalogue
Group Actor Catalogue
Information Catalogue
Programme Catalogue

Project Catalogue
Stakeholder Catalogue
Technology Component Catalogue
Technology Node Catalogue
Technology Product Catalogue




Hide a Slot (e.g., Costs)

This scenario will take you through how to hide a slot from a user. Adding classifications
to slots will hide certain aspects of the organisation from the user (e.g., costs) in order to
protect that information, but still allow a user to view things related to those costs.

Dashboard Capture Publish Import -

Go to Tool/Modeller and select ‘Configure’, then
‘Repository Administration’”.

Configure =

Class Editor
Slot Manager

System Administration

b | REPOSItory Administration

2 Select ‘Manage Classifications’.

Ed essential

spture  Publinh mport w

Configue w

Repository Administration
(amn\

‘\#/7 Manage Repository Users
o\

l.@ } Create Snapshot

—

((.‘.\

===) Manage Snapshots
\&==/ 8 P

i) (¥) )

Protege Import

Protege Export

Manage Layout Groups

22\
{ ) Restore Snapshot
) P

Manage Classifications

v/_
{ Q]\/ Copy Repository
N

@

Theme Editor

3 ‘Create New (Security) Group’, or take note of the levels within the group.

> Team France

Frinch Preson atindee 10 omesd )] gheat)

Create News Group

Currently lagpec ista repasitary: "Deme” oo ualtesl

Current Version: 1.12.4

Create New Level Cdit Celete

bolpt v
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o e e = = = ———— = = ———— — -

,’ If adding New Classification Level, enter Name ‘I
! and confirm. |
|
| |
\ |
] New Classification Level |
| |
\ |
! I
' |
N /"
Create New Levels, Edit the group
name, or Delete the group.
> Security TES(GI‘OUP > Create New Level Cdit ] Delete l
Low Lewwl a2 indece 1 |1 owest! eair delete
Med Levalatindex 2 edit decte
Hiph Level at index 4 [Highest) d deste

I Change the order of the index
by dragging the dots to desired
order.

5 ‘Edit’ the level name, or delete it.

Next go to Manage Repository Users, select the user(s) you want to make security
7 classification changes to. For the example, this user has no Security Test Group
clearances. After this, select Update.

(61 Clonrarae Lavels
Maragement | cwest Patidl View () Execstives W Uneestrcned View
Anabyts fowe O Teotowt —
W manages
—
—
) A Member [’ ------------------------------- \\
‘ i
: Warning! The changes you have made wil not take efect until the user nest signs in. Logout. \
. ! |
]
e | Note the warning after clicking update. Updates |
! will only be applied when the user next logs in. |
\ /’
~




You can see ‘Cost’, and all the costs

of the organisation

» O TosiTomponent

-

O Rescurce Optimisatian

-

0 L fecwele Manarement

@ Cost Comporent Change

Experion Custs
Faster Meter Impementstion Costs
Full Erergy Applications Savings Costs

Class Tree Hide | Instance Browser {de
¥ O SYSTEM-CLASS > AMS Fleet Solutions Costs M
» O EASysiem > Autodesk Costs
~ O EAclass > BlackCurve Costs
v o L"J""""_ Layer Bloomberg Intelligence Costs
» O Apeh "”uf:r' Layes » Busliness Procoss Automation Project Co
> O Information Layer » ClearPaint Strategy Casts
» O Technclogy Layer
» O EASupport »  ClowdBuy Costs
» O Strotegy Management »  Contractlarks Casts
» O Charge Management ?» CredsCosts
» O Standards Manogement » CTXGlobsl Costs
¥ O Governance > Debtlrack Costs
» O Risk Managemert > DEICell Erergy Manager Costs
» O Security Nanagement 5 DMS Costs
» O Serdce Delivery EncrzyCao Costs
'o Ubligau'cr Management > Enhanced Data Analytics Costs
e tan: ant
' 2 ::;:Ir;n:pn:;;\aarn}gtrr = 3 Entronis FMP Casts
v O CostManagemant > Fesential Casts
Cost 3 Everleam Cosls

Go to :SYSTEM-CLASS > :META-CLASS > :CLASS >
:STANDARD-CLASS > :ESSENTIAL-CLASS.

Class Tree 1 Hide Instance Browser ide
» DSSTIM-OLASS Adhoe Cost Companent
* O METACLASS > Annua_Cozt_Compenent
v O LCAss > CONTRACT_TO_COST_RELATION

ANDADCRSS
@ :ESSENTIAL-CLASS (10

PO CONSTRANT
b O CANNOTATION

> Cost_Comgonent_Type
> Cost_Nanagement

Cost Compgenent Change

» O RELATION » COST NGT RELATION
b O FARMation > Nenthy_Cost_Componont
» O o] > Quartarly Cest_Canpanent

v O EACass
PO Busewss Laywr
b O Aoplication Layer
b O Infermation Lager
Tec hnaiopy | ayer
EN Supoort
O Strategy Maragemant
O Churge Nanupemeet
C Sta~dards Managemet
O Gosrnance

O Risk Mansgremect

¢

r v www 0O

£ Sae rth Mansmamane

Facum Fapons Calaps

Yanvre

Search Classes tost

Search ‘Cost’ in search bar.

f

1 Select ‘Cost’.

10



:ESSENTIAL-CLASS

Lyrtem Security
LAt Classfication

v

INAL StCunay i‘.";'l\l

12 In ‘Cost’, select Security, then ADD/NEW in
System Security Read Classification.

DEPRECATED

System Secerity
Read AO2NEN

L | Clssnicaton

w

¢

(

D My Classifications - Management

O MyClssifications - Top Secret

1 3 Select security level, highest option as the slot is being

hidden. Then ‘Select’.

LM LVITIWETTIL L@ aomivauivn

General Security - Uncestricted View

My Classifications - Analysts

Security - masagement

Security Test Group - Low Level

Secunity Test Geoup - Med Level

Cancel

1 4 Publish the new security classification.

4 Publish

Available Target Viewers O Larpe
154 Cemo
0 Small
S
Progress Ready...

11



1 5 When the user goes to ‘Cost Management’ in the Class Tree, can no longer see
‘Cost’ and the instances in it.

Class Tree Hide Instance Browser Hd2
LA PR TN R
v O FALIes No instovices o oA 2hoss fho Mistance o1ocicd

PO Business | wper

» O Applestion Laywe:

» O Infarmsicn | sper

» O lechnoopy wper

v O LASupoert

O Stratezy Mamapement
Cha~ge Mrragement
Sta~cards
Goerrance

Risk Management

Security Management
Service Delwery
Oblgaton Nanagement
Ferformaroe Nanagement
Lopal Nunapempet

Coat Managemant

O Cosl Companent

@ CostTomganent Change 1]
¥ 0 Resourc: Spomzanon

» O Lrecydle Namgement

» O Tasonamy Namagement

nagement

o0

Y O

o (=}

~oloo

v

b O Utiities
A Canambaliamnn
P Lezard Coligne
Search Classms Seacth instasoes

6 Go to Knowledge Portal from Dashboard and select ‘View Library’.

- Q ©«a 92 v i =) 2 & JordiCarter «
View Library
All Enterprise Business Information Application Technology Support catalogues

. = Application Capability Catalogue
Enterprise = Application Catalogue
= Application Catalogue
Application Business Fit Application Cost Appﬂgatloncos( Application Design * Application Function Implementation
Analysis Dashboard Overview Authority
Catalogue

Pravides a matrix view that maps s n averview of the key
the d * Application Service Catalogue

Business Capability Catalogue
Business Domain Catalogue
Business Objective Catalogue
Business Process Catalogue
Business Service Catalogue
Data Catalogue

Data Representation Catalogue

1
-

) O
) O

T
.- .

Group Actor Catalogue

Application Duplicati \pplication Footprint Application Service Cost Application Service
Analysis Comparison vs Supported Revenue Rationalisation Analysis

Supports comparizan of the

Information Catalogue
Information Store Catalogue

Provides a means to analyse the

functional footarin: of twe opportuniti atanalise the * Physical Data Object Catalogue
applications apalications providing a glven = Programme Catalogue
- e S *= Project Catalogue
- - ) T = - = Roadmap Model Catalogue
= o = Stakeholder Catalogue
[r—— = Technology Component Catalogue

Technology Node Catalogue
Technology Product Catalogue

12



1 7 In the Application section of the View Library, when
the user selects ‘Application Cost Analysis’...

Application Capability Application Cost Application Cost Application Cost
Summary Analysis Summary Semmary

% ¢

- = - =
Network Summary o Sumamary Asatysis
R
- - . B
e = = o = o
Application Function Application Impact Application info/Data Agplication Information
Summary

Implementation Analysis Dependency Model

1 8 ...it will take them to this screen.

View: Application Cost Analysis -

You do not have permission to access costinformation

1 9 You can see here that access was blocked to only one of the Cost Analysis viewers.

Jordi Carter ~

View: Application Cost Summary for ADEXCell Energy Manager

i= Description

Real tme energy consumation menttaring of facllities

m Differentiation Level

System of Differentiation

ofo Application Services

Load Control
Load Forecasting
Mater Tracking

Asset Mapping Services
Budgeting & Forecasting
Contact Management Serdces
Emissions Monitoring

Emargy Prce Analysis

BH Costs
- Total Cost
" som $221,000

W Server Cost [S20,000]

7% Surage Cowt [$100,000]

13



Return to add
security
classifications
to add each

Go to :SYSTEM-CLASS > :META-CLASS > :CLASS
:STANDARD-CLASS > :ESSENTIAL-CLASS.

2 21

Configur

*
EEE essent|a! Dashboard Capture Fublish mport v
dou

Class Trea Y e v

Instance Browser Hie cost
— — ‘ESSENTIAL-CLASS v
ey e o ] o Rt
v & Class > CONTRACT TO COST RELATON
v @ :STANDARD-CLASS y Cost
@ essenmiavcass Al T AL | MAIN  ADDTIONAL | SFCURITY  SYSTFWM  DEPRECATED
»  Cor_Companent
» CSLOT
» o FACET > Cow_Component_Cranpe 4 -
' O CONSTRANT » Com_Component_Type Main
P O ANNOTATION 3 Con er.q_'bﬂ'ﬁ"l
» O RELATION ) COST_MGT_RELATION ROLE -
) > Marhly Cost_Compenent Concrete e
» D o > Quarterty_Cost_Component
— oz :DOCUMEKTATION
’ Siness Layor ADD
P O Aoplcabicn Layer Represents an amount of money that is spent on an LA
b QO reemation L .cl:mcmmc':nzc ‘.3:;-crccom‘f.:
» O Technology Lages
* QO EASupport
P O Stralegy Mueupement SLOT- .
» C Change Management CONSTRAINTS ADDYREW
[ 2+ .‘.l.«-..lu;hr.'u-.ag.nwnl
» O Gowernooce
» G Risk Nanagemert
B M St Manunarmant
:DIRECT
[T pund Coluzw New Marepn TENPLATE-SLOTS ADDINEW
Search Classes oost
| Use instance browser search bar to view all cost
H ", "
related instances (e.g. “cost”).
.
You can see that all cost related instances have now had the
high level security classification applied to them.
» O ANNOTATION > My Classifications - Management System Secured pR—
» O RELATION > My Classifications - Top Secret Road Elements o .
» O EARdaton > Securils ssment W Security Test Group - High Level
- o ® Cost
- 8 Adhor Cow Companent

O [ASecurity

> Security Test Group - Low Lewval

@ EA Content Classification (L
@ EA Content Clazzd cation Grou
@ FAlser

Q FADelwult Clussilivation

| Mnual_Cost_Component
® CONTRACT _TO_COST_RELATION

> Security Test Group - Med Lewel

® Cost_Component
@ LA System 10 Management |2 W Cost_Component_Change
@ Cast Companent Type

-
[e]

FA System U1
* @ EAGrRpn Management B Cost_Maragement

v O EACIass @ COST_MGT_RELATION

v O BusmessLoyer | Monthly_Cos Companent
» O Apclication

O Application Luyer m Quartery_Cozt_Componant
» QO Infermaticn Layer

Faus Exzend Celuzas b N

System Secured
Cdit Clements

Swarch Clisses Search Inslances

@ Security Test Grewp - Hign Lewsl

Carrently lopped inta repasitoey: "Deme™ oo uathest

14




2 Now opening the Dashboard you can see the applications, but actual details of the
costs are classified.

View: Application Cost Dashboard - $3,200,000

v DASHBOARD FITERS
FISCALYEAR From: 3012 To:  2p18

OWNING ORGANISATION

COST TYPES Maintenance Cost Server Cost Storage Cost Licensing Cost People Cost Database Cost Third Party Cost

Micraaof Projc Sansee
Bicombeg risligance

$ S S

TOP 10 APPLICATIONS COST BY TYPL € |al
N (CLASSIFIED] I (CLASSFIED, I (CLASSIFIED] I (G ASSIFED) I (CLASSFIED|
B (CLASS/FIFD] I [CLASSIFIED] [CLASSFIFD] I (1 ASSFIFDY
AN o | By Ny | N (CLASSFIED]
uml,ii:.l\f: I (CLASSFIED]
Emtronic EMP | — I (C1 ASSIFIFTY
PriceOntiisatinn | S B
VIASP Frecvtin I (CLASSFIED|
RlackCLrs CLASSFIED
CaarPoint Straregy I (CLASSIFIED]
[EEE— ]
[EEE—— ]

%,

%,
e,
iy,
%%
%,

APFLICATON COST 3Y CODERASE ¢ APPLICATION COST BY DELIVERY MODEL © lal
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Hide a Single Slot

To hide a single slot, follow the instructions up to 7 in 2a, and then follow the steps below:

Select EA Support, Cost
Management, and cost.

Class Tree Hae Instance Browser Hide
~ O EAClass
A Bise ) > ANS Floet Solutions Costs
b G Business Layer
» C Application Layer Autodesk Costs
VO Infaemaian | apee BlackCurvw Casts
» O Techroogy Layer > Bloomberg Intell gence Cozts
—— > Business Process Aulomalion Progect Cost
¥ O ntegy Mansgement > ClearPolnt Strategy Costs

Charge Marapement
Starcards Managemens

CloudB.y Costs
Contracterks Costs
> Crecs Cozts
CTGlabel Costs
» DebtTrack Costs
DEXCell Energy Marager Costs

*AS Conts

* O Governsnce

* O Rk Management
L]
r O

Seourity Management
Service Dalueey

L]
L]

Cblgation Mamagomert
Peclarmarcs Wanugement
Q Legal Masspromeet
* O CostManagement >
[ vea ] .,

¥ © Low Comp

Enhuncwd Dats Anniytics Cos s
Entronie EMP Costs
Essential Costs

® Cow: Componet Change |14 .
Fuenream Casts

» O Resowrce Cptimsation
* O Lifecycls Nanagement > Experan Costs o
y O _;‘mnnmy N’mas‘,"_‘m' Faster Meter Implemuentstion Costs
» O Utilities > Ful Energy Applications Savirgs Costs
.- - Fmndtam Frrbe
Focus Egparad uleprn New MNetgs

Search Classes Szarch Instarces

EncrgyCap Costs Q-—

Select the Cost you want to hide,
e.g. EnergyCap Costs.

v

Cost

ALL MAIN AROITIONAL SECUmTY SYSTEM DEPRECATER

Main
Name EnergyCap Costs
Description
Stakeholdurs

ADOMNEW
Cost Components

ADOMEW

W Hoztrg CostinEnergyCap Costs

Instance Browser Hide

Cost

v

v

AMS Flect Solutions Costs
> Mutodess Costs

BlachCarve Cosis

% instance References 8]

> Bloomberg Intelligence Costs ALL
> Businzzs Frocess Mtomation Project Cost:
ClesrFoint Strategy Costs . i
Clewd3uy Costs 5 QC L rl t'y
> CortractWorks Costs -
> Creds Costs
CTXGebal Casis
> DebaTrack Costs
> DEXNCal Energy Manager Costs
DMS Costs

Bl EnargyCap Costs

System Swourity
Edit Classification

O Select security, then ADD/NEW System Security Read Classification.

SECURITY  |SYSTEM

MAIN ADDITIONAL DEPRECATED

ADDMNEW

System Security
Read Classification

> Enhanced Data Analytics Costs
Entronix ENP Costs

ADDNEW

Fassntal Casts

> Everteam Coss

> bxgeran Costs
Faster Meteer Implemectation Casls
Full Energy Applications Savings Casts

N mmsldan Caste

Hew Marage

16



Give a User Access to Only One Layer (e.g., Business Layer)

This scenario will show you how to provide access to only one layer (e.g., Business Layer),
meaning a user can only see the area they are working on, and other areas of the
organisation is kept secret from users without appropriate clearances.

Dashboard Capture

Go to Tool/Modeller and select ‘Configure’, then
‘Repository Administration’”.

Publish  Import - | Configure w

—_—

Class Editor

Slot Manager

System Administration

Repository Administration

111 essential
- 4

2 Select ‘Manage Classifications’.

Configue w

Repository Administration

(ama\
‘\#) Manage Repository Users

()

\&=3) Create Snapshot

=\
‘@ Manage Snapshots

722\
{ ) Restore Snapshot
\«/ P

—
\ Q]) Copy Repository
h.

((-) Protege Import

@ Protege Export
~

Manage Layout Groups

"
il

Manage Classifications

(.’) Theme Editor

3 ‘Create New (Security) Group’, or take note of the levels within the group.

> Team France

Frinch Preson atindee 10 omesd )] gheat)

Create News Group -

Currently lagpee ista repasitany: "Deme” oo ualtest

Current Version: 1.12.4

Create New Level Cdit Celete

folnte

Al:cul Exwntial

220142020 EAS. All Rights Reserved.  JE@AS




Create New Levels, Edit the group
name, or Delete the group.

> Security Test Group
Low Lenwl a2 indee 1 (L owest,

Med Levslatindex 2

P ——— e — e, — e — e ———————————— -

If adding New Classification Level, enter Name '
and confirm.

New Classification Level

- Create New Level Cdit | Delete |

Hiph Level at index 4 [Highest "

edit

delste

delete

delsle

Change the order of the index

by dragging the dots to desired
order.

5 ‘Edit’ the level name, or delete it.

7

Next go to Manage Repository Users, select the user(s) you want to make security
classification changes to. For the example, this user has no Security Test Group
clearances. After this, select Update.
(61 Cloararce Lovels
Maragement t Pavtial View Executives M Uneestricoed View
v ol V' Macagemant +
Arabyits [Low Top Secret & Meragermenm
¥ g
—* ow Level Lowe Med Level Mgh Level |
- A Memder ~e rd cTTTTTTTTTTTTTTTTTTTTTTTTTTTTTTT = N\
: Warning! The changes you have made wil not take efect until the user neat signs in. Logout. :
! '
\ I
e ! Note the warning after clicking update. Updates |
- : will only be applied when the user next logs in. |
N !
e = I b b b -
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8 Recommended to do this, so now classify everything other than the business layer.

= (Classify everything in the repository except the Business Layer with a specific classification
— Business Layer has no classifications
— Do not clear the set of people for this classification
— No way to classify the Business Layer for other users, e.g. Application Layer users, such that they cannot see it

Recommended approach
= (Classify all classes in the repository except the Business Layer classes approach is recommended for this use case

= Current: oCTTTTTTTTT T "
' 1
— Build a DUP that makes use of a library script to define the set of “allowed” classes 1 Current best way to select entire layers to '
— Script performs the following steps : be classified, APl or build a DUP. Otherwise
* Create the new Security Classification Group and Security Classifications in that group 1 very time consuming for admin to apply :
Using the library script, classify all classes except those in the meta model tree of the Business Layer class . classifications. :
* Planned: A !
— Invoke API to implement the required security
Go to 1. :SYSTEM-CLASS > :META-CLASS > :CLASS 1 Select the Class that
> :STANDARD-CLASS > :ESSENTIAL-CLASS needs classifying.

Class Tree l it Instance Browser
ot S vt :ESSENTIAL-CLASS -
> Bxtornal_Systom_Even "

< syl = 11 S0 to securlty and
o ;’;;:én;d.:-‘(ikss — — AL MAIN - ADOITIONAL SYSTEN | DEPRECATED ;e etCt ASDD/N‘EtWR d

GCEIG] MJ‘L .‘:nf“'“ stem Securi y ea

. > Time_Sased_System_Event S 1 Y! i A

o consTIAN Security Classification.

O ANNOTATION

System Swcurity

o
Q RFLATION
QG EARelation Edit Classification

System Security
Read ADO/NEW

Classification

faul o
® EASystem (0 Nanapement

+ G FASyseml

FAGraph Manageeent
> EAClass

m

o)

Busing

Use the class tree to find which areas need

classifying, and search for that class in the

:ESSENTIAL-CLASS' instance browser.

e e [ v | « Do this for each class that needs classifying, then
repeat steps 2-4.

*  Will need to do this for each class of every layer.

0

O Application Conceptual

Fonus Bpand Colapee New Warage

1 2 Add the desired level of classification.

v EA Content Classification

- D -

) General Security - Uncestricted View
My Classifications - Analysts
My Classifications - Managemsent
My Classifications - Top Secret

Securty - management

I Security Test Geoup - High Level
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Class Tree Hide

O Aaplicaticn Layer
» O Application Concepual
v O Application Legical
~ @ Application Service (12
® Composite Application Service
® Application Function (&l
@ Application Family
v O Application Provider Type
v @ Application Provider (1)
® Composte Application Proy
® Application Provider Interfa
® Application Function Implemes
@ Software Component |3
v @ System Event
@ Time Basad System Evert
@ Extornal
» O lLogical Application Mede:

stem Event

@ Logical Soltware Architecture |1

» O Logical Soltware Architecture Typs
@ Application Provider Rale (21%

O Application Physical

Information Layer

Technology Layer

coo -~

EASupport
O Adout Essential

Focus Expand Collapze

Search Classes

Instance Browser ide

>

>

>

>

>

g
v
e £ ABC
External_System_Eve .‘.BL
Initiating_System_Event_Usage

Ralsed_System_Event_Usage

System_Event_Usage

Time_Based System Event

New Manage

I system_event

|+

Use the expanded Class Tree to help when searching for the classes in the instance
browser. You will need to do the same for every class in the Information and
Technology Layers as well — repeat steps of previous slide to do so.

:ESSENTIAL-CLASS v

T K

ALL | MAIN  ADDITIONAL | SECURITY  SYSTEM  DEPRECATED
Security
System Security
ADONEW

Edit Classification

System Security
Road ADDNEW
Classification @ Security Test Group - High Lewvel

1

Class Tree ice

v

Instance Browser

-CLASS
O EASystem
O FACAss
v O Business Layer
¥ O Business Conceptual

@ Gusiness Pringiple

@ Business Domain

@ Business Capability (A5
@ Gusiness Role Type (1

-

® Contepbusl Business Even

-

C Conteplual Business Mod
@ Procuct Co pt .3

@ Businass Criver

® Skill Type

@ Yalue Stream 121

@ Value Stage |F

G Business Ohjectve Type
v © Buslness Logica

C Business Role

C Business Process Type
@ Business Event |1

@ site Category =

C Logkal Business Noded
@ Froduct Typs 1

v v -

v -

tosas Expand Lellagow

Scarch Instances

Search Claszes

o instances (or this dloss

1o Inslovace Sulecied

Once complete, all layers and classes classified will be invisible to any user without appropriate
clearances. In this case, only the Business Layer and the claises in it are still visible.

Class Tree Hide Instance Browser

siness O we Type .
O Businezs Objective Typ o instances far thls class
0 Business Rele

O Business Process Type
® Business Event (151

® Ste Catepory 5

»
¥ O Business Logical
>
»
>

» O Logical Business Medel
» @ Produdt Type 14
® Business Rule

» @ Product (°2
® Branad
® Channel
® Praduct Feature
® Praduct Feature Implemen
® Business Precess Family 12)
® Customer Jourrey
® Customer Jourrey Phase
® Business Condition (3

» 0 Physical Process Type
» O EASupoort
» O About Essential

otus Expand Colaoee
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The next slides will go through the second method of classifying all layers except
one — works for leaving specific instances unclassified if that is what is required,
otherwise ignore.

Without a DUP or API, there are a number of ways to classify the layers that you want to be.

Class Tree lide Instance Browser Hide

EA Content Classification v

» O SYSTEM.CLASS > Base - lowest

v O EASystem > Base- Management I _— ‘ O Dalets Instance m
—> ¥ O EASecurity > General Security - Executives
® EA Content Classification (17
@ EA Content Classification Grou

> General Security - Management ALL MAIN ADDITIONAL SECURITY SYSTEM DEPRECATED
> General Security - Partial View

® EAUser
© EADefault Classification > General Security - Unrestricted View L
@ EA System ID Management » My Classifications - Analysts [\Ad N
» O EASystemU > My Classifications - Management
» @ EAGraph Management » My Classifications - Top Secret Name . 0504 faabS
» O EAClass >_Security_management = Jreslialaraasatlests
=
> Security Test Group - Low Leve Description

> Security Test Group - Med Level

1 Go to the desired 1 6

security level. ADD/NEW in

System Secured

Read Elements ADDNEW... System Secured
@ Security Test Group - High Level
® Adaptasility and flexibility Read Elements.
. Frpirnd ¢ N W
! ' ' " System Secured
Edit Elements ADD/NEW..
Search Classes Search Instances @ Security Test Group - High Level

17 Now add classifications to the Layers you want to hide, e.g. Application Layer.
« EAClass
Select | Cancel |
Q
- >
» Business Layer 5
» Application Layer 5
» Information Layer >
» Technology Layer 5
» EASupport >
» About Essential >

21




1

19

Within Application Layer, one after

| v Application Layer

the other enter Conceptual, Physical, a
and Logical. -

»  Agplication Conceptual

> Agpiication Logical

» Asplcation Physical

« Application Conceptual

In each of these select the class to add

classifications to. (e.g. Application

Q

Capability).

Note that you will need to do this for
each class individually i.e. Application ——

»  Agplication Architecture Principle (2)

»  Agplication Capability 67)

Architecture Principle, Application > Aopiiation Dever

Driver,

Type.

and Application Objective

»  Agplication Objective Type

Select

2 As the entire layer is being
classified, select all the instances.

v Application Capability

Account Planning
Asset Installation
Asset Management
Business Management

Business Planning

Business Strategy Development

Business Support

2 1 Then Select once done.

New |

|

Cancel
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The classes/

22

15-21 for every layer that the user is not going to have access to.

instances now show in Read Elements. Repeat steps

Class Tree Hide
» O SYSTEN-CLASS
~ O EASystem
v © EASecunty
® EAContant Clasaification 17
@ EA Content Clazssification Grow
@ EAUser
© EADcfault Classification
@ EA Systern 10 Manasgement |1
» C EASystemU
» @ EAGrRph Management
» O EAClass

Eepard Cologse

Search Classes

Instance Browser Hide System Secured

Read Elements ADD/NEW...
> Buse-lowest ® Sccurity Test Group  High Leved
> Base-Management ® Adaptability and Nexbilty
> G g # " . X .

Genaral Securky - Executhve @ Corverpene wilh the enlerprise acchibectume
> General Security - Management

. urty e @ Account Planning
> Genersl Security - Partial View
N @ Azset Instalation
> General Security - Unrestricted View
. " N . B Asset Namegement
> My Chasifications - Malyzs Busi M )
- iness Manspemen
> My Classifications - Management - AR

RBusiness Plannin
My Classilications - Top Secmet o Pl nning
- . @ Business Strategy Dovelopment
Securily - managpement

Bl Security Test Group - Migh Level

> Security Test Group  Low Level

® Business Support
® Colsboration

> Securlty Tost Graup - Med Lawe @ Commerdial Management

@ Compatitor Analysis

® Commissioning Excoution

® Content Authuring

@ Compliarce Manitarag

@ Content Callahoratian

@ Contract Management

® Contract Tendering & Management
® Credit Manapement

@ Customer Campaign Planning

® Customer Relatonship Mgt

® Do Management

Kew Menage

Search Instarces

® Dowument Authorng

- Friccinne Manaoamant
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After either of these methods have been completed, only anything related to the (e.g. Business) layer will be
accessible to a user without clearances to view more. Users will still be able to view areas that are related to

multiple instances, but anything unrelated to the (e.g. Business) layer will not be accessible/viewable.

You can see in this view
that business capabilities
are still visible.

The applications
(unrelated to anything in
the business layer) are
now classified.

—_

—_—

Corporste Management
[ atenal
‘W Carpavare Wk — e R
A s vagerat Maragmrient

Copy Encel v POF Print Search

THIRD
APPLICATION SUPPORTY OATABASE PARTY MANTENANCE HOSTING STORALL LICINSING
NAME DEICRIPTION cost cosr cosY cost cost cosY cosr TOTAL
[CLASSIFIED CLASSIFIED) 000 000 s 000 $10,000 000 $111,000
CLASSIID CLASSINILD 020 1,000 0 $100.000 $176.000
[CLASSIFIED CLASSIFIED] $75,000 $1,000 50 525,00 $10,000 %0 $131,000
[CLASSINED CLASSINED] $25,000 000 $0 5,000 0,000 200 @ $71,000
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Changing Clearances for Multiple Users at Once

This scenario will show you how to change the clearances of multiple users at once,
rather than having to give each one individual access, you can add/remove clearance
from one user to as many as all of them, customisable to your specification.

1 In the EDM Tool, select ‘Configure’, then
‘Repository Administration’.

Dashboard Capture Publish Import w Configure w

Class Editer
Slot Manager

System Administratian

Repasitory Administration I

2 Select ‘Manage Repository Users’.

111 essential Owbowd Catre PaiMA  bapert v | Conlgus v

Repository Administration

o\ \
\* ,: Manage Repository Users T \ (- ,I Protege Import
4

Create Snapshot Protege Export

Manage Snapshots Manage Layout Groups

Restore Snapshot Manage Classifications

Copy Repaository o ) Theme Editor




B T T ———

‘
1 Use filter to search for specific users, and
| select All/None if required.

\

Select all the users you want to change
account roles and edit & read clearances for.

O Repository Administration - Manage Repository Users — 4 Once all desired

selected, select

Sebect Al | Select Nome  TUsers Selacted

edit.
> how v eatre Prt Copy
* Flrst Name Last Name Actve Tnactive
v < Active
O Active
™ Nel Active
~ Active
0 = Active
17 n Actve
v 3 Acte 0 15
154 ha Active 027
e 1
: Navigate pages of users, also increase/decrease the number of users per page.
You can now edit all of the selected user’s account roles, their edit
clearance levels, and their read clearance levels.
Repository Administration - Edit Multiple Users v
Users 7 Users Selected Read Clenrnnce Liuwis Genreal Smcurity
Account Roles Clasy/Shot ESter . R
2se
- hd h"jll-\\lﬁ: oo
mport Data . v
) L Socurtty .
nstance Editor Secuwrily Teed Ceoup
Publisher v BATeom
Repotory Admin - A Tewn
Edit Clearance Lovels General Security .
e v Team France
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Add/remove the desired security clearance(s). E.g.
Read Clearance: Security Test Group — High Level.

RA Tear

F0ad Cleanance Lovels

hone
Low Level
Med Lewel

7 Once added/removed, select update. —

Pead Charance Levels sl Secuty

8 When all changes have been made and
updated, select close.

User Status activelinactive
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Security Clearances and Classification Summaries

Set a Default Classification

- This scenario allows you to set a default classification for all users in the repository
that it’s applied to. Once applied, only users with matching or higher security
clearance than the default will be able to access every class and instance that the
default has been applied to.

Hiding a portal
- This scenario demonstrates how to hide a portal from a user, portals can define which

views that the users see. E.g., hiding the entire data management portal will restrict
access to that portal, but not strictly to the views within it, which will have to be
classified separately if they are going to be hidden from all portals, they can be
accessed from.

Hiding a view

- This scenario will show you how to hide a view (report) from a user. Simple process
that will demonstrate how to hide a view from a user, hiding a certain view if there is
one aspect you want to hide from a user. (e.g., IT Asset Dashboard) will mean the user
cannot get an overview of the IT assets, but can still access other, more specific views
involving these assets.

Hiding an instance

- This scenario will take you through hiding an instance from a user. Once applied the
instance will be hidden from all users that don’t have the security clearances. E.g., Can
hide Equipment Management as a capability from the user and can apply to any
capability that needs to be hidden.

Hiding a class
- This scenario shows how to hide a class from a user. Areas of each layer can be split so

that a user can only access certain aspects of that layer. E.g., Classify the entire Business

Conceptual class, but allow other aspects of the business layer to still be visible, i.e.
business logical and physical, as well as catalogues such as business services catalogue.

Hiding a set of classes

- This scenario allows you to hide a set of classes from a user, providing a quicker method
of hiding multiple classes at once rather than having to apply classifications to different
classes individually.

Hide a slot

- This scenario will take you through how to hide a slot from a user. Adding classifications
to slots will hide certain aspects of the organisation from the user (e.g. costs) in order
to protect that information, but still allow a user to view things related to those costs,
e.g. the applications being used still visible, but not the cost of those applications

Changing clearances for multiple users at once

- This scenario involves changing the clearances of multiple users at once, rather than
having to give each one individual access, you can add/remove clearance from one user
to as many as all of them, customisable to your specification.
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Give a user access to one layer

This scenario will show you how to provide access to only one layer (e.g., Business Layer),
meaning a user can only see the area they are working on, and other areas of the
organisation is kept secret from the users without appropriate clearances.

Give a user access to certain reports/views
- This scenario will allow you to make only certain reports/views accessible to a user
depending on what you want them to be able to see. Instead of hiding each view

individually, this will help to speed up that process and hide as many as you need to
all at once.




